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ArcWeld PowerPac 4.0 User's Guide 

Features

ABB ArcWeld PowerPac 4.0 includes a series of useful features: 
RAPID Preview 
Activate Collision Set 
Path Planner 
Upload Support 
Demo Stations 

How to use this manual

This manual contains general information about the ArcWeld tools and workflow. 
It is designed to be used either as a reference tool or as a step-by-step guide to 
learn the sequence of work when you work with ArcWeld. The manual consists of 
four chapters: 

Installation 
Introduction to RobotStudio 
Introduction to ArcWeld 
Working with ArcWeld 
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Installation
In this section you will be guided through the installation process; it will help you 
install ArcWeld properly on your PC. The installation process consists of four 
steps:  

1. Installing the software 
2. Requesting your license key 
3. Registration of your license key 
4. Connecting the add-in 

Prerequisites
To complete the installation process, you must have the following at hand:  

ArcWeld PowerPac CD 
License Certificate 
The computer on which you install ArcWeld PowerPac must fulfill or 
exceed the system requirements. 
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License Certificate
The License Certificate is a document that includes: 

User Information 
License ID 
List of licensed products 
Expiration date (if any) 

The certificate can be found inside the product packaging together with the User's 
Guide and CD. Keep this document for future reference. Please do not discard. 
To retrieve a license key you must refer to the license ID listed in this document. 
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System Requirements
Software Requirements 

Microsoft Windows NT 4.0 with Service Pack 6 or higher and Internet 
Explorer 4.0 SP2 or higher  
Microsoft Windows 2000 Professional with Service Pack 1 or higher  
Microsoft Windows XP Professional (note: Home Edition is not supported) 
Note: Windows service-packs can be downloaded from www.microsoft.com 
RobotStudio 4.0

Recommended Hardware 
CPU: Pentium III or higher 
Memory: 512 MB RAM 
Free disc-space: 500+ MB on system disk, 250+ MB on installation disk 
Video Card: A high performance video card with OpenGL support, such as  
nVidia GeForce series, nVidia Quadro series, ATI Radeon series or ATI 
FireGL series. 
Screen resolution: 1280 x 1024 pixels 
Three button mouse 
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Installing ArcWeld
1. Insert the ABB ArcWeld PowerPac 4.0 CD in your computers CD-ROM drive. If 
the CD does not start the installation automatically, double-click on the Setup.exe 
file found in your computers CD-ROM directory. 
2. The InstallShield Wizard starts and will guide you through the installation 
procedure. 

3. Make sure that you select the same Destination Folder as RobotStudio 
(normally C:\Program Files\ABB Robotics).  
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4. Select Typical installation.  

5. Complete the installation wizard and push Finish.
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Request License Key for ArcWeld
To complete the license key request form, you must have the following 
information at hand:  

Company Information, like contacts and type of business.  
The License ID, which can be found on your License Certificate.  
Basic Information about the computer on which you are installing 
RobotStudio.   

To request your license key, follow these steps: 
1. Log on to your computer with a user account that has Administrator rights. 
2. In the Windows taskbar, click Start button and then click Programs>ABB
Automation>System Information.
3. The System Information dialog is displayed. Go to the Products tab and in 
the Installed Products field, select RobotStudio.
4. Push the "Request License Key for RobotStudio" button to open the License 
Key request Form and select Next.

5. Enter End User Information and select Next.
6. Enter System Information and select Next.
7. Enter License Type, License ID, Product Options and select Next.
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8. Enter Business Information and select Next. 
9. Select the "Save registration as..." button to save the file "License Key 
Request Form.txt" on your hard drive. 

Follow the instructions in the "Registration Completed" window and select Finish.
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License Key
To run ArcWeld you will need a license key. The license key is a password that 
ABB will provide. You can not use ArcWeld before you have received your license 
key.

The license key will be sent to you after your license key request form has been 
processed and approved. The email will include a license key file (*.lic). This file 
includes the key strings for the software you have purchased. Save this file to 
your hard drive so that you can register your license keys. 

The license key will only be valid for the computer on which you install 
RobotStudio and ArcWeld. Therefore, make sure that you install these products 
on the intended computer.  

Notice that the license key will be invalid if you change your file system, for 
instance, from FAT32 to NTFS or vice versa. 
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How to Register Your License Key
When you receive your license key file, you need to activate ArcWeld by 
registering the license key.  

To register your license key, follow these steps:  
1. Click the Start button in the Windows taskbar. Select Programs>ABB 

Automation >System Information.
2. Click the Licenses tab and click the "Import Licenses from file..." button.  
3. Browse to the license key file (*.lic) and click OK.
4. Click OK again to exit the System Information dialog.  
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Add ArcWeld in RobotStudio
After the installation is completed and the license key is registered, notice that a 
new tab called ArcWeld is added at the bottom of the browser. Verify that this is 
the case on your computer. If so, your installation is successfully completed. 

If the ArcWeld tab does not appear you need to add ArcWeld to the RobotStudio 
user interface manually by following these steps: 
1. Start RobotStudio.
2. Open the Tools menu and select Add-Ins...
3. Push the Add... button. 

4. Browse to the directory C:\Program Files\ABB Robotics\Addins\ArcWeld. 
5. Select the file ArcWeld_4_0_Loader.dll and push Open.
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6. Verify that the entry Show ArcWeld Tab is added to the list of Add-ins, and is 
checked.
7. Push OK.
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Introduction to RobotStudio 
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RobotStudio™

RobotStudio is a highly advanced simulation and off-line programming software 
with a number of outstanding features and benefits 

3D-simulation environment - full 3D representation of robotics system 
Virtual Controller - the real robot controller embedded in your PC 
Robot Library - exact models of the entire ABB robot product line 
Virtual Teach Pendant -perfect for training operators off-line 
RAPID Program Editor - automatic program error checking 
I/O Simulator - interact with simulated inputs/outputs 
Visual Basic for Applications - develop your own functionality 

The goal is to make robot programming more efficient by using RobotStudio than 
using the traditional teach pendant. This section presents a brief overview of 
RobotStudio. For more information about RobotStudio, go to 
www.robotstudio.com 

Functionality
Creation of motion path 
Cycle time estimation and optimization 
Programming and validation of complete production programs  
Collision detection and visualization 
Feasibility studies and reachability tests 
Easy evaluation of standard components 
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Risk Reduction
New installations can be verified by quickly building up your station; making 
accurate feasibility studies; verifying reachability, collisions and singularity issues. 
Build up the station easily with powerful layout tools, using measurement devices 
and full graphical object manipulation. RobotStudio includes modeling functions of 
Solids, Surfaces and Curves, and advanced CAD import capabilities such as 
ACIS, IGES, STEP and VDAFS. With the kinematics modelling tool it is possible 
to put kinematics on your own models. 

Quicker Startup
Programming time can be cut, and above all, take place before the system is 
installed. RobotStudio is designed for geometry based motion programming.   
This means, easy creation of paths and targets on geometry along curves and in 
intersections. After the targets are in correct positions you can modify target 
orientation, check tool orientation, set robot axis configuration and program 
external axis positions.  

Shorter Changeover
Changes in existing installations can be tested, or production programs for new 
parts in production can be updated. The virtual controller enables true program 
roundload i.e. it is possible to upload production programs, make changes and 
download the new program back to production. Maintain and optimize existing 
production programs to increase quality and productivity 

Optimize Program
RobotStudio provide several tools to make it easy to optimize robot programs 

Cycle time calculation 
Plot TCP movement 
TCP speed monitoring 
Axis monitoring 
Roundload of programs 

Application Development
RobotStudio has a very flexible and open architecture. The Application 
Programming Interface (API) is based on Microsoft's Visual Basic for Applications 
(VBA), and provides easy and powerful access to the core of RobotStudio. This 
allows you to develop your own special tools and applications. 
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Off-line Programming
The traditional way of programming a robot task is to do the programming by 
robot teaching. The programmer moves the robot arm to a desired position, and 
records the position in the controller. By repeating this procedure, robot positions 
are stored as a sequence in a program. This method is known as on-line 
programming. On-line programming prevents the robot to be productive during 
programming, so the next step would be to free up the robot for production and 
develop the robot programs in a separate system.  

ABB has developed an application that is a dedicated programming tool for 
generating arc weld programs. This application is called ArcWeld PowerPac and 
is based on RobotStudio. ArcWeld PowerPac and RobotStudio utilize the CAD 
geometry as the basis for all robotics programming. The programmer defines weld 
locations on the CAD geometry and creates robot positions in relation to the 
geometry. This method is known as geometry-based offline programming. 

Simulation vs. Off-line Programming
RobotStudio can be used for pre-studies during the engineering stage of a 
project. Engineers may want to test different concepts and station layouts; verify 
the reach of a certain robot; get an estimation of cycle time, or check for collisions 
in tight areas. The virtual robot system will be displayed in detail on the PC 
monitor, and it will give the engineer a visual understanding of the system that is 
being developed. This method is known as simulation. 
The level of detail and accuracy in a simulation can vary a lot, depending on what 
questions that the simulation is trying to answer. If the engineer is trying different 
station layouts, the positioning of models and the accuracy of the models 
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themselves does not have to be very accurate. If the goal is to check for reach 
and collisions, both positioning and modeling has to be more accurate. If the 
simulation is trying to estimate the cycle time, all components has to be in exactly 
right positions and the virtual robot has to simulate the exact behavior of the real 
robot. Ultimately, if the simulation is made with a very high degree of accuracy, 
the simulation could be used as the foundation for off-line programming. The 
output from a simulation is often a video clip that shows how the robot will move in 
the workcell, in contrast to off-line programming, where the output is a fully 
functional robot program. 
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Virtual Controller Technology
ABB's robot controller is developed in a high level programming language, which 
makes it possible to port the controller software to any type computer platform. To 
make the Virtual Controller run on a PC it was ported to the Windows NT platform. 
This means that exactly the same code running in the real S4 controller is now 
also running on the PC. This has opened up a new world of possibilities and 
enabled features like; the virtual teach pendant, the I/O simulator and the 
ProgramMaker text editor. All these components are directly connected to the 
virtual controller in run-time, which enables live interaction with robot programs on 
a PC.

With RobotStudio connected to the Virtual Controller, ABB has been able to 
create a replica of the real robot system in a simulation environment. These are 
the most obvious benefits that this technology brings; 

Accurate cycle time simulation 
Accurate simulation of path behavior 
Full controller language support for off-line programming 
Up-/download of robot programs without translators 
Use of configuration files from the real controller 

It is possible to create several instances of the virtual controller, allowing you to 
create a virtual copy of each one of your real robot controllers. To help you 
manage and administrate your virtual robot systems, a Virtual Robot Browser is 
included with RobotStudio. The virtual robot browser is where you set up the 
connection between the 3D robot models and the virtual controller. 
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Synchronize RobotStudio and Virtual Controller
It is important to keep the virtual controller and the 3D graphics in perfect 
synchronization, which requires exact mapping between graphical objects and the 
RAPID language. A target in the graphical environment will generate a robtarget 
definition and a move instruction in the virtual controller. A path including targets 
in the graphical environment will generate a routine with move instructions in the 
virtual controller. 
This is the basic workflow: 

1. Create and modify targets and paths in the graphics environment  
2. Synchronize paths to the Virtual Controller  
3. Enhance the program structure and add logic steps in the RAPID text 

editor 
4. The resulting program resides in the Virtual Controller and is ready for 

download to the real controller 
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See an illustration of the synchronization process below: 
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RobotStudio User Interface
This is the RobotStudio user interface: 

1. Menus
2. Toolbars
3. Browser
The browser displays all objects in the station in a hierarchic fashion. You can 
toggle between the Object Browser and the Program Browser by clicking the 
tabs in the lower section of the browser. 
4. Graphics Window
The graphics window displays the 3D images of all the objects. You can also 
select and manipulate objects here. 
5. Output Window
In the output window messages from RobotStudio and the Virtual Controller are 
displayed. 
6. Status Bar
The status bar displays some of your current settings. It also displays the status of 
the Virtual Controller. 



30

Operate the Graphics View
In this section you will learn different ways how to operate the graphics window.  

Operate the Graphics View with the Mouse
Place the mouse pointer above the Graphics window. Your mouse pointer is 
above the graphics window; you can now click for graphic selection. 

Rotate
In this mode you can rotate the station around the current view center. 
3-button mouse
Click and hold down both middle and right mouse button. 
2-button mouse
Hold down Ctrl and Shift and your right mouse button. 

Pan
Pan the view by holding down Ctrl and drag with the left mouse button. 

Zoom
If you drag to the left you will zoom out, if you drag to the right you will zoom in. 
3-button mouse
Hold down and drag with the middle mouse button. 
2-button mouse
Hold down Ctrl and drag with the right mouse button. 
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Window zoom
Hold down Shift and drag with the right mouse button, adjust so that the square 
covers the area, which you want to zoom in. 

Selection area
Hold down Shift and drag with the left mouse button, within the square area all 
objects of the same type as your Selection Level will be selected. 

Operate the Graphics View with the View Toolbar

1. Click the Zoom In and Zoom Out buttons to change the view of the object. 
2. Click the View All button to have the zoom adjusted so that all objects in the 
station are displayed in the view. 
3. Click at an interesting point in the view and click Set View Center. The center 
of the view is adjusted so that zoom and rotate now centers on the new point. 
4. Click View Front/Right/Top to have the view adjusted to that direction. 
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Operate the Graphics View with the View Menu
1. Open the View menu.

2. Click Browser. This hides the Browser window.
3. Click Output Window. This hides the Output window. 
4. Click Property Browser. This hides the Property browser. 
5. Click Status Bar. This hides the Status bar. 
6. On the View menu click Reset Workspace. This resets the workspace of 
RobotStudio to the default settings. 
7. Point to the Navigation sub-menu. 

8. On the Navigation sub-menu click View All. The zoom is adjusted so that all 
objects in the station are displayed in the view. 
9. Click something in the Graphics window. On the Navigation sub-menu click 
View Center. The center of the view is adjusted so that zoom and rotate now 
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centers on the new point. 
10. On the Navigation sub-menu point to View Point and click one of the 
predefined view points.  

11. On the View menu, point to Toolbars sub-menu and click on any of the 
entries to toggle toolbars on or off. 
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Selection Levels
To be able to select objects in the Graphics window, you first have to determine 
the selection level of the object and then select the object for action. An object 
can be selected on different levels, so you have to specify what type of 
component you want to work with. The selection levels are:  

Curve
Surface
Entity
Part
Assembly
Mechanism
Targets/Frames 
Path

Target/Frame and Path selection can be combined with any of the other selection 
levels.

Set the Selection Level using the View Menu
To set the selection level, follow these steps: 

 1.    In the View menu, click Selection Levels…

 2.    In the Selection Levels dialog, select the requested level. 

3.    Click OK.



35

Set the Selection Level using the Selection Level 
Toolbar
To set the selection level, proceed as follows: 
 1. In the Selection Level toolbar, click the selection level you want to use.  

Select objects in the Graphics window
To select objects in the Graphics window, follow these steps: 
 1. In the Selection Level toolbar, choose the Selection Level you want to work 
with.
 2. In the Graphics window, click the object. The selected object is highlighted in 
the graphics window as well as in the object browser. 

Select objects in the Object browser
To select objects in the Object browser, proceed as follows: 
 1. Click the object in the Object browser. The selected object is highlighted in the 
object browser as well as in the graphics window. 

Multiple selection of objects in the Graphics 
window
To select multiple objects in the Graphics window, proceed as follows: 
 1. In the Graphics window, hold down the SHIFT key and click the objects one at 
a time.  

Multiple selection of objects in the Object browser 
To select multiple objects in the Object browser, follow these steps: 
 1. In the Object browser, hold down the SHIFT key and click the objects one at a 
time
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Snap Modes
The Snap Mode allows you to specify where on an object the marker will snap to, 
when you pick objects in the Graphics window.                             
To snap to… …use the Snap 

Mode:
The nearest endpoint, midpoint 
or corner  

Snap

The nearest endpoint or corner End 
The midpoint of the object  Mid 
The center point of the object  Center 
A user-defined grid of points  UCS Grid 
The gravity point of the object Gravity 
The local origin of the object Local Origin 
The nearest edge Edge 

Set the Snap Mode using the View Menu 
To set the Snap Mode, follow these steps: 

 1. In the View menu, click Settings>Snap Mode Settings….

 2. In the Snap Mode Settings dialog, select the Snap Mode you want to use: 

3. Click OK.
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Set the Snap Mode using the Snap Mode Toolbar 
To set the selection level, proceed as follows: 

 1. In the Snap Mode toolbar, click the snap model you want to use.  

Turn Off Snap Mode 
The Snap Mode you specified will continue to be activated until you turn it off.  To 
turn the Snap Mode off, follow these steps: 
 1. In the View menu, click Settings>Snap Mode Settings...
 2. In the Snap Mode Settings dialog, click the Clear All button. 
 3. Click OK.

Change the Snap Radius 
To change the maximum distance to the edge or corner where the Snap Mode is 
activated, follow these steps: 
1. In the Tools menu, click Options.
2. The Options dialog is displayed. 
3. Select the Graphics tab and in the Selection Radius field, enter a new Snap 
Radius (mm). 

4. Click OK.
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Coordinate Systems
A consistent way to define positions in the room is a fundamental task in all robot 
systems. Therefore, coordinate systems are used. In RobotStudio you are able to 
specify which coordinate system you want to use, e.g. when positioning or 
rotating a target. All coordinate systems are color coded according to the following 
definition; 

Red = X-axis 
Green = Y-axis 
Blue = Z-axis 
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Tool Center Point
The Tool Center Point (TCP) is a coordinate system at the end of the robot arm or 
at the tip of the weld torch. It is used to define the position that the robot is 
reaching. When the robot is reaching a target, the XYZ-axes of the TCP will be 
aligned with the XYZ-axes of the target. 

The robot can use different TCP for different weld torches. If no particular TCP is 
specified, the default TCP tool0 will be used. Tool0 is located at the tool mounting 
plate at the end of the arm. 
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Motion Type
The robot motion planner can move the TCP in three different ways;  

Linear: Moves the TCP with constant speed along a straight line towards next 
target. Basic RAPID instruction is MoveL.

Circular: Moves the TCP with constant speed in a circular path towards the next 
target. Requires an intermediate "circle point" to define the radius. Basic RAPID 
instruction is MoveC.

Joint: Starts all joints at the same time and stops all joints at the same time. This 
motion type is used to maximize speed (optimized acceleration and deceleration), 
but the path of the TCP is unpredictable. Basic RAPID instruction is MoveJ.
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Target
A target is a point with a specific orientation in the 3D space. It defines how the 
robot TCP should be oriented when reaching that point. On the screen all targets 
are indicated as small coordinate systems. 

A target has the same properties as the robtarget in the RAPID language. These 
properties are position, orientation, robot axis configuration, external axes 
configuration, motion parameters and process parameters. 
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Path
A path is a sequence of targets, where the order of the targets indicate how the 
robot should move. In the RAPID language, a path is translated into a RAPID 
procedure, which contains at least one move or process instruction. 

In the graphics window a path is represented with a line between the targets. 
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User Coordinate System
In RobotStudio you are able to specify which coordinate system you want to use 
as reference, when positioning targets or other objects. You can use the object’s 
own local coordinate system, a movable coordinate system called the User 
Coordinate System (UCS).  

In the picture above, the World coordinate system is set as UCS. 
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Robot Library

RobotStudio includes a complete library of ABB robots. The robot models are all 
based on the original CAD drawings used for manufacturing, which guarantees 
exact dimensions of the virtual robots. The concept of using library components 
makes it easy to quickly load robots and other equipment into a RobotStudio 
station. Instead of copying the library component into the station, the RobotStudio 
will create a reference to the library file (*.rlb). This will ensure that the latest 
revision of library components will be used in all stations. It is also a good method 
for managing disk space. The robots are stored on your hard drive in the following 
directory:
C:/Program Files/ABB Robotics/Library/Robots 
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File Structures
RobotStudio is using several different file types. Stations are saved as station files 
(*.stn).The station file is using a subdirectory with the same name as the station 
file and the extension "_supporting files". In the subdirectory you will find 
geometry files (*.sat) and graphics files (*.jt) plus a backup version of the station 
file (StationBackup.stn). 
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Library components are saved in library files (*.rlb). The library file is also using a 
subdirectory with the same name as the library file and the extension "_supporting 
files". In the subdirectory you will find geometry files (*.sat) and graphics files (*.jt). 
See how library files relate to station files in the illustration below. 
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The advantage of using library components is the way you save disk space. 
RobotStudio is referencing files from the library instead of copying geometry and 
graphics files into the station file every time a component is loaded. However, 
when you need to modify a library component, it first has to be disconnected from 
the library. This means that the geometry files and graphics files are copied into 
the station file and sub-directory. See the illustration below. 
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After creating or modifying an object in RobotStudio, you can save the object as a 
library component. This means that a library file is created and the geometry files 
and graphics files are moved from the station sub-directory into the library sub-
directory. See the illustration below. 

It is possible to import solid models from CAD files into RobotStudio. See the 
illustration below. 

To read more about importing CAD files, read the CAD Import section. 
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CAD Import
RobotStudio provides models of robots, positioners and some commonly used 
weld torches. Models of parts and fixtures has to be provided by the end user. 
Normally users does have drawings or models of their parts and fixtures, so the 
capability to import CAD models into RobotStudio is essential. This section is 
trying to explain the most important concepts involved in CAD import. 
2D-Drawings vs. 3D-Models
CAD systems were originally designed to replace the pen and the drawing board. 
The main purpose was to output a printable, two-dimensional paper drawings. 
Over time CAD systems have evolved to also be capable of representing parts as 
three-dimensional models. Older 3D systems construct solids by manually 
creating trimming surfaces, then sewing them into a closed volume (a.k.a. surface 
modeling). Newer systems, in contrast, derive solids via construction history. 
Models get built up bit by bit with features and parameters (a.k.a. parametric solid 
modeling). 
Native File Formats vs. Neutral File Formats
RobotStudio is strictly based on 3D solids and will not import 2D drawings. 
Importing solids can be done through direct import using RobotStudio's native file 
format ACIS (.sat), or importing a neutral file format such as IGES (.igs) or STEP 
(.stp) through a translator. RobotStudio is delivered with an IGES translator and a 
STEP translator is optional. 
Many CAD systems such as SolidWorks and AutoCAD can export 3D-models in 
the ACIS file format. Some systems does not have this capability and in these 
cases 3D-models would have to be exported to a neutral file format (IGES or 
STEP), and then imported to RobotStudio through a translator. 
Pre- and Post- Processing
Exchanging data via either IGES or STEP requires two translators, one on each 
system. Software on the exporting CAD system, called pre-processor or writer, 
reads the CAD file and produces a version formatted in accordance with the IGES 
or STEP specification. The file is then moved to the importing system (i.e. 
RobotStudio) where a post-processor or reader creates a version in the format of 
the importing system (i.e. ACIS). 
IGES vs. STEP
IGES is as good as it is ever going to get. The Initial Graphics Exchange 
Specification went through its sixth, and final, revision in the year of 1999. As the 
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U.S. standard for exchanging data between dissimilar CAD systems, it has over 
time expanded to include most geometry concepts used for part modeling today. 
It is now rare to find a full-blown CAD system that doesn't support some version of 
IGES.
Does all this mean CAD drawings and models pass flawlessly between systems 
via IGES? Not quite. There are still issues that can either prevent drawings from 
translating at all or that cause problems in the translated drawing that weren't in 
the original. The same can be said for the more comprehensive and still evolving 
STEP standard. The STandard for the Exchange of Product model data is an ISO 
standard (10303) describing not just part geometry, but also information about 
how the part is to be manufactured. It is becoming widely used as means of 
transferring 3D models between dissimilar solid-modeling systems. 
Difficulties with CAD Translation
Data translation through IGES and STEP is becoming more important because of 
increased emphasis on collaborative projects involving multiple teams. The bad 
news is that translations still cause trouble. The good new is that the causes 
generally are well understood. 
Difficulties in the past have arisen because IGES allows geometric entities and 
annotations to be represented in a variety of ways. When a post-processor does 
not understand some of the entities a preprocessor supports, it may just ignore 
them. An unrecognized entity may even crash the post-processor. 
Another problem that remains is that not all CAD users have up-to-date 
translators. Earlier versions of IGES did not support all of the 3D geometry 
constructed by widely used CAD systems. Such difficulties are most pronounced 
when passing models between CAD systems that employ two different modeling 
approaches e.g. surface modeling and solid modeling. 
Tolerances are perhaps the thorniest issue plaguing the solid model translation 
today. CAD systems from different vendors each employ differing base-line 
tolerance levels for such fundamental geometric considerations as whether or not 
two lines or end points coincide. Translating a model created with loose 
tolerances for use by a systems with tighter tolerances generally causes 
problems, irrespective of whether or not the incoming model is in IGES or STEP 
format. The method to overcome such difficulties is what's called a healing 
process. A special healing program is used to examine files and determine what 
is not translating properly. 
One way to work around difficulties from differing CAD-system tolerances is to 
devise native-to-native translators. Problem is, feature definitions and mating 
relationships between parts gets lost in translation, just as in STEP and IGES. 
There are other direct translation methods as well. Spatial Technology's ACIS 
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kernel is a software library that CAD system developers can use to manage 
geometry and topology. Parasolid from Unigraphics is a similar library. Neither 
ACIS or Parasolids handle drawings or non-geometric part attributes. 
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Access Help Files
If you wish to know more about the RobotStudio user interface and how to 
navigate the windows you can always access the RobotStudio help files. 
1. On the RobotStudio Help menu click Help.
2. Expand the How to Work with RobotStudio node by clicking the + in front of 
it. Here is all the information for further studies on your own. 
3. Expand the How to Work with Shortcuts node by clicking the + in front of it. 
4. Click the Shortcuts in RobotStudio node to open the help text on the subject. 
This is a very useful list to print out and have next to your computer while learning 
RobotStudio. 
5. In the help on the File menu click Exit.
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Introduction to ArcWeld 
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Introduction to ArcWeld
This chapter explains features and terminology unique to ArcWeld. Some of the 
most important features are: 

Program Module 
Weld Sequence 
Path
Weld 
No Sequence Paths 
Node Status 
Markers 
Indicator 
Reference Coordinate System 
Torch Angles 
Templates 
Default Weld Templates 
Target Classification 
Target Status 
Automatic Robot Configuration 
Path Planner 
Upload Support 
My Stations 
Help
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Program Module
Program modules are listed in the Modules View. A program module includes 
Weld Sequences and No Sequence Paths. Insert weld sequences to a program 
module by right-clicking on the entry in the modules view and selecting Insert 
Weld Sequence from the context menu.  

A program module in ArcWeld is equivalent to a program module in RAPID 
(.mod). Synchronizing the program module "MyModule" will generate the following 
RAPID code: 

MODULE MyModule 
...
ENDMODULE
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Weld Sequence
A weld sequence is a sub-component to program modules and is simply a holder 
of paths in a sequence. Insert paths to a weld sequence by right-clicking on the 
entry in the modules view and selecting Insert Path from the context menu. 
Execute the weld sequence by right-clicking on the entry in the modules view and 
selecting Execute from the context menu. The robot will execute the paths 
according to the sequence from top to bottom. 

When synchronizing the weld sequence "MyWeldSeq" to the Virtual Controller it 
will be translated into a RAPID procedure. This procedure only include calls to 
path procedures.  

PROC MyWeldSeq() 
   Path1; 
   Path2; 
   Path3; 
ENDPROC

Notice that a path can be dragged and dropped from one weld sequence to 
another. It is also possible to rearrange the order of paths in a sequence by 
simple drag-and-drop operations.  
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Path
A weld path is a sub-component to a weld sequence and includes a sequence of 
targets that makes a continuos path. Insert targets to a path by right-clicking on 
the entry in the modules view and selecting Create Targets from the context 
menu. This will open the Create View. Edit the path by right-clicking on the entry 
in the modules view and selecting Edit from the context menu. This will open the 
Edit View. Execute the path by right-clicking on the entry in the modules view and 
selecting Execute from the context menu.  

The difference between a weld path and a regular path in RobotStudio is that it 
includes weld instructions. When synchronizing the path "Path1" to the Virtual 
Controller it will be translated into a RAPID procedure. This procedure includes a 
sequence of RAPID instructions.  
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PROC Path1() 
    ActUnit STN1; 
    MoveJ pPath1_1,vmax,z10,tWeldGun\WObj:=obSTN_1; 
    ArcL\On,pPath1_2,v200,sm1,wd1,wv1,fine,tWeldGun\Wobj:=obSTN_1\SeamName:="Path1 Weld 1"; 
    ArcL pPath1_3,v200,sm1,wd1,wv1,z5,tWeldGun\Wobj:=obSTN_1; 
    ArcC pPath1_4,pPath1_5,v200,sm1,wd1,wv1,z5,tWeldGun\Wobj:=obSTN_1; 
    ArcL\Off,pPath1_6,v200,sm1,wd1,wv1,fine,tWeldGun\Wobj:=obSTN_1; 
    MoveL pPath1_7,vmax,z10,tWeldGun\WObj:=obSTN_1; 
    MoveJ pPath1_8,vmax,z10,tWeldGun\WObj:=obSTN_1; 
    ArcL\On,pPath1_9,v200,sm1,wd1,wv1,fine,tWeldGun\Wobj:=obSTN_1\SeamName:="Path1 Weld 2"; 
    ArcL\Off,pPath1_10,v200,sm1,wd1,wv1,fine,tWeldGun\Wobj:=obSTN_1; 
    MoveL pPath1_11,vmax,z10,tWeldGun\WObj:=obSTN_1; 
ENDPROC

Notice that a path can be dragged and dropped from one weld sequence to 
another. It is also possible to rearrange the order of paths in a sequence by 
simple drag-and-drop operations. 
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Weld
A sequence of weld instructions in a path is defined as a weld. A weld always 
starts with an ArcX\On statement and ends with an ArcX\Off statement. You can 
easily select an entire weld in the Target List.  

The path below includes two welds. The same weld selected in the target list 
above is highlighted in the RAPID code in blue. Notice that each weld has been 
given a unique name by using the SeamName argument in the ArcX\On 
statement. 

PROC Path1() 
    ActUnit STN1; 
    MoveJ pPath1_1,vmax,z10,tWeldGun\WObj:=obSTN_1; 
    ArcL\On,pPath1_2,v200,sm1,wd1,wv1,fine,tWeldGun\Wobj:=obSTN_1\SeamName:="Path1 Weld 1";
    ArcL pPath1_3,v200,sm1,wd1,wv1,z5,tWeldGun\Wobj:=obSTN_1;
    ArcC pPath1_4,pPath1_5,v200,sm1,wd1,wv1,z5,tWeldGun\Wobj:=obSTN_1;
    ArcL\Off,pPath1_6,v200,sm1,wd1,wv1,fine,tWeldGun\Wobj:=obSTN_1;
    MoveL pPath1_7,vmax,z10,tWeldGun\WObj:=obSTN_1; 
    MoveJ pPath1_8,vmax,z10,tWeldGun\WObj:=obSTN_1; 
    ArcL\On,pPath1_9,v200,sm1,wd1,wv1,fine,tWeldGun\Wobj:=obSTN_1\SeamName:="Path1 Weld 2"; 
    ArcL\Off,pPath1_10,v200,sm1,wd1,wv1,fine,tWeldGun\Wobj:=obSTN_1; 
    MoveL pPath1_11,vmax,z10,tWeldGun\WObj:=obSTN_1; 
ENDPROC
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No Sequence Paths
The No Sequence Paths node is a sub-component to program modules and is 
simply a holder of paths, which are not included in a weld sequence. For instance, 
this can be paths used for torch cleaning or torch calibration.  

Insert paths to No Sequence Paths by right-clicking on the entry in the modules 
view and selecting Insert Path from the context menu. Notice that any path can be 
dragged and dropped from/to No Sequence Paths. 
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Node Status
The status of an item in the browser is displayed with different colors of the node 
icon.  

The upper field of the icon indicates the status of the node in the RobotStudio 
station.  

White means that the status of the path is unknown.
Green means that all targets in the path are reachable, and execution of 
the path has been verified by the robots motion planner. 
Yellow means that all targets in the path are reachable, but execution has 
not yet been verified by the robots motion planner. 
Red means that at least one of the targets in the path is unreachable.

The lower field of the icon indicates the status of the node in the Virtual Controller. 

White means that the path does not exist in the Virtual Controller. 
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Green means that the path exists in the Virtual Controller, and the path in 
the Virtual Controller is synchronized with the path in RobotStudio. 
Yellow means that the path exists in the Virtual Controller, and the path in 
the Virtual Controller is not synchronized with the path in RobotStudio. 
Red < this state will never occur > 

Examples: 

Status of path in station is unknown, and the path does not exist in the Virtual 
Controller 

All targets in the path are reachable and verified. The path does not exist in 
the Virtual Controller. 

All targets in the path are reachable but not verified. The path does not exist
in the Virtual Controller. 

At least one of the targets in the path is unreachable. The path does not exist
in the Virtual Controller. 

All targets in the path are reachable and verified. The path in the Virtual 
Controller is synchronized with the path in RobotStudio. 

All targets in the path are reachable and verified. The path in the Virtual 
Controller is not synchronized with the path in RobotStudio. 
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Markers
ArcWeld utilize the CAD geometry as the basis for all programming. The 
programmer defines weld locations by clicking in on the geometry. Each click is 
indicated by graphical markers in the graphics view. These markers help the 
programmer to interact with ArcWeld and the graphics environment. 

Example:
Go to the create view and select add weld. In the selected positions frame click 
the start point (marked with a yellow sphere), click the end point (marked with a 
red sphere), and then click the base plate face (the normal to the face is marked 
with a blue cylinder). Notice that the exact coordinates are automatically entered 
into the in X, Y, and Z fields. 
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Indicator
The indicator is an object in the graphics window that works as a graphical cursor. 
The shape of the indicator resembles a weld torch and gives you a chance to view 
the torch angles with out having to use the robot or the active tool center point 
(TCP). The size of the indicator can be changed from the view settings in 
ArcWeld. The indicator is automatically visible in the graphics view when a target 
is selected in the target list.
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Reference Coordinate System
It is important that the user has full control of the tool orientation when creating a 
weld. To obtain full control of torch angles, a reference coordinate system is 
introduced at all weld positions. The Reference Coordinate System (RCS) 
definition is as follows: 

X-direction: Is parallel to the welding direction. A small red square is located at 
one side of the XZ-plane to indicate the positive X-direction. 

XZ-plane: Is perpendicular to the base plate and is indicated with a blue square. 

XY-plane: Is determined by the X-direction and XZ-plane and is indicated with a 
green square. 



66

Torch Angles
The RCS and the TCP are used to define the torch angles in relation to the 
workpiece. The tool orientation is defined through three different torch angles:  

Work Angle: The angle between the XZ-plane of the RCS and the z-axis of the 
TCP. The picture below shows an example of work angle -30 degrees. 

Push/Drag: The angle between the XY-plane of the RCS and the z-axis of the 
TCP. Push means that the angle is negative and the torch is leaning away from 
the welding direction. Drag means that the angle is positive and the torch is 
leaning towards the welding direction. The picture below shows an example of -20 
degrees push angle. 
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Spin Angle: The rotation of the torch around the z-axis of the TCP.  

The picture below shows an example of 0 degrees spin angle i.e. x-axis of TCP is 
aligned with the X-direction of the RCS. 

The next picture shows a spin angle of -45 degrees. 

The "Auto" feature sets the spin angle so that X-axis of the TCP is pointing away 
from the base of the robot. This will make it more likely that the robot can reach 
the target. 
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Templates
Normally when using RobotStudio the user first creates targets and then connects 
them into a path. The user has to define target position, target orientation, robot 
configuration and external axes values for each individual target. This is a time 
consuming process with a lot of repetitive operations.  

ArcWeld is using templates to simplify creation of targets and paths. By using 
templates the user can focus on settings for the entire weld rather than looking at 
targets individually. All settings are predefined in templates and can be applied 
repeatedly throughout the programming of a part.  

Weld Template
The weld template is a collection of weld parameters, where each weld template 
describes a type of weld situation. There is a number of predefined weld 
templates available: 

Linear two point 
Linear in to corner 
Linear out from corner 
Linear corner to corner 
Linear around corner 
Circular 3 point 
Circular 3 segments 
Circular 5 segments 
Boss circular 6 segments 

 For more details see section Default Weld Templates. 

Process Template 
A process template is a collection of process parameters and instruction 
arguments. Process parameters are read from the virtual controller and can be 
grouped together in a process template. Any combination of process parameters 
can be saved as new process templates. For more details see section Process 
Template View.   

Every target in a process template is assigned a classification. This enables the 
user to apply instruction arguments to individual targets in a weld, such as  
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seamdata
welddata 
weavedata 
process type 
motion type 
speed
zone

When that targets are synchronized to the Virtual Controller, the following 
instructions will be generated; 

MoveJ p1, vmax, z10 ...
ArcL/On p2, v200, sm1, wd1, wv1, fine ...
ArcL p3, v200, sm1, wd1, wv1, z5 ...
ArcL/Off p4, v200, sm1, wd1, wv1, fine ...
MoveL p5, vmax, z10 ...
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Default Weld Templates
ArcWeld is installed with some default weld templates, which are used when 
adding welds. Each template require input selections. Depending on which 
template is selected, a combination of the following inputs are required: 

Start Point Click on the geometry where the weld should start 
End Point   If linear, click on the geometry where the weld should end 
  If circular 3 point, click on the geometry where the weld should 

end
  If circular X segments, click on the geometry along the circular 

edge after the Circ Point 
Circ Point Click on the geometry along the circular edge, between the 

Start Point and the End Point 
Corner 
Point 

Click on the geometry exactly on the corner, between the Start 
Point and the End Point 

Each template has the following settings: 

Work 
Angle 

see section Torch Angles 

Push/Drag see section Torch Angles 
Spin Angle see section Torch Angles 
Offset Y Offset distance of path in relation to RCS Y-axis.  

Useful to avoid collision detection between wire and part. 
Offset Z Offset distance of path in relation to RCS Z-axis.  

Useful to avoid collision detection between wire and part. 
Offset  Offset distance from start/corner/end point along the weld 
Angle Angle from start point to end of circle segment 

Below you will find graphics and tables describing the default weld templates. 
Notice that weld templates can be duplicated and modified in the Weld Template 
View.



71

Linear two point 

Index Classification Work Angle Push/Drag Spin Angle Offset Y Offset Z Offset
1 Start 45 0 Auto 1 1 0 
2 End 45 0 Auto 1 1 0 

Linear in to corner 

Index Classification Work Angle Push/Drag Spin Angle Offset Y Offset Z Offset
1 Start 45 0 Auto 1 1 0 
2 p2 45 0 Auto 1 1 20 
3 End 45 -20 Auto 1 1 0 
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Linear out from corner 

Linear corner to corner 

Index Classification Work Angle Push/Drag Spin Angle Offset Y Offset Z Offset
1 Start 45 20 Auto 1 1 0 
2 p2 45 0 Auto 1 1 20 
3 p3 45 0 Auto 1 1 20 
4 End 45 -20 Auto 1 1 0 

Index Classification Work Angle Push/Drag Spin Angle Offset Y Offset Z Offset
1 Start 45 20 Auto 1 1 0 
2 p2 45 0 Auto 1 1 20 
3 End 45 0 Auto 1 1 0 
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Linear around corner 

Index Classification Work Angle Push/Drag Spin Angle Offset Y Offset Z Offset
1 Start 45 20 Auto 1 1 0 
2 p2 45 0 Auto 1 1 5 
3 p3 45 0 Auto 1 1 * 
4 p4 45 0 Auto 1 1 5 
5 End 45 -20 Auto 1 1 0 
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Circular 3 point 

Index Classification Work Angle Push/Drag Spin Angle Offset Y Offset Z Offset
1 Start 45 0 Auto 1 1 - 
2 End 45 0 Auto 1 1 - 
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Circular 3 segments 

Index Classification Work Angle Push/Drag Spin Angle Offset Y Offset Z Angle
1 Start 45 0 Auto 1 1 0 
2 CircEnd 1 45 0 Auto 1 1 120 
3 CircEnd 2 45 0 Auto 1 1 240 
4 CircEnd 3 45 0 Auto 1 1 360 



76

Circular 5 segments 

Index Classification Work Angle Push/Drag Spin Angle Offset Y Offset Z Angle
1 Start 45 15 Auto 1 1 0 
2 CircEnd 1 45 0 Auto 1 1 30 
3 CircEnd 2 45 0 Auto 1 1 132 
4 CircEnd 3 45 0 Auto 1 1 233 
5 CircEnd 4 45 0 Auto 1 1 335 
6 CircEnd 5 45 -15 Auto 1 1 365 
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Boss circular 6 segments 

Index Classification Work Angle Push/Drag Spin Angle Offset Y Offset Z Angle
1 Start 45 5 Auto 1 1 0 
2 CircEnd 1 45 0 Auto 1 1 60 
3 CircEnd 2 45 0 Auto 1 1 120 
4 CircEnd 3 45 0 Auto 1 1 180 
5 CircEnd 4 45 0 Auto 1 1 240 
6 CircEnd 5 45 0 Auto 1 1 300 
7 CircEnd 6 45 -5 Auto 1 1 360 
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Target Classification
Process Templates are using attributes on targets to store its classification. A 
target is always classified into one of the following categories; 

Air Move: Intermediate target between welds. Generates a MoveJ or MoveL
instruction, depending on motion type 

Approach Move: First target before a weld. Generates a MoveJ or MoveL
instruction, depending on motion type. Is "connected" to the following Process 
Start target, so that the orientation always follows the process start point with a 
variable approach distance. 

Process Start: First target in a weld. Generates an ArcL instruction with the 
argument /On (activates the weld process). 

Process Via: Intermediate target in a weld. Generates an ArcL or ArcC
instruction, depending on motion type. 

Process End: Last target in a weld. Generates an ArcL or ArcC instruction, 
depending on motion type. Sets the argument /Off (deactivates the weld process). 

Depart Move: First target after a weld. Generates a MoveL instruction. Is 
"connected" to the preceding Process End target, so that the orientation always 
follows the process end point with a variable depart distance. 
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Target Status
The status of a target is displayed with different colors in the target list.  

White means that the status of the target is unknown.
Green means that the target is reachable, and execution has been 
verified by the robots motion planner. Execute the Move To Target 
function to reach this status. 
Yellow means that the target is reachable, but execution has not yet been 
verified by the robots motion planner. Execute the Jump To Target function 
to reach this status. 
Red means that the target is unreachable.

The goal is to turn all status fields green before synchronizing the path to the 
virtual controller. 
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Automatic Robot Configuration
It is usually possible to attain the same target position and orientation in several 
different ways, using different sets of axis angles. We call this different robot 
configurations. The picture below show an IRB140 with two different arm 
configurations used to attain the same position and orientation.  

In RobotStudio the user must select robot configuration manually for each target. 
This is done by right-clicking on a target in the object browser and selecting 
"Solutions..." from the context menu. Up to sixteen different solutions can 
sometimes be found. It can be difficult to understand what each solution really 
means and it is very time consuming to find the best solution for each target.  
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To help the user ArcWeld will select robot configurations for every target 
automatically. The selections are based on the input given in the robot 
configuration control. ArcWeld also looks at the robot configuration of the previous 
target in the path to avoid large reconfigurations between targets.  

How to Control Robot Configuration
1. The first time a path is loaded in the Edit View the target status is unknown.  
2. As you select targets in the target list ArcWeld will automatically select 

robot configurations based on the input given in robot configuration control. 
3. You can verify the robot configuration by executing the Move To Target 

command in the Edit Toolbar.  
4. You can force new solutions by changing the settings in the robot 

configuration control. For example, set Axis 4 and 5 to zero and alternate 
Axis 6 between + and -. You will notice that the robot will spin axis six in 
different directions when moving towards the target depending on your 
settings.  

5. It is suggested that you always start with the first target in a path. Try 
different settings in the robot configuration control until the robot moves 
according to your wishes. 

6. Then select the entire path and push Move To Target. ArcWeld will 
reassign robot configurations along the path based on the robot 
configuration of the first target in the path. 

7. Iterate this process until you are satisfied with the robot configurations of 
your path. 
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Path Planner
The path planner is used for programming air moves between welds. The 
programming of welds is based on templates and does not benefit from the path 
planner. 

Path planning is done in three simple steps: 
1. Test path in the Edit View to check for collisions. 
2. Run path planner in the Create View. Path planner will automatically add 

targets to avoid collisions. 
3. Verify results in the Edit View. Use editing tools if necessary to avoid 

remaining collisions. 

Notice that the path planner is a "programming assistance tool" and not a 
"programming replacement tool". The results are not guaranteed to be collision 
free. The resolution of the path planner are sometimes not high enough to catch 
all collisions, and some collisions may persist after the path planner is done. The 
programmer will always have to check the path for collisions, and sometimes may 
have to modify targets to avoid collisions completely. 

The video clip below shows a very simple case where the path planner 
automatically avoids a collision by adding additional targets. Reload this page to 
run the video clip again. 
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Upload Support
A path procedure that was originally created in the virtual controller does not 
appear in the RobotStudio station until synchronized.  

Sync to Station in RobotStudio
Go to RobotStudio's Program Browser, right click on the procedure and select 
Sync to Station. 

A path will now be created in the station and visible in the Object Browser. 
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Sync to Station in ArcWeld
A path procedure will appear in the ArcWeld Browser, but can not be edited until 
synchronized.  

Right-click the path node and select Sync to Station.  

Targets and a path is created in RobotStudio and now the path can be edited in 
ArcWeld. Right-click the path node and select Edit.  
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A path can only be synchronized to the station one time. If you make changes to 
the path it can be synchronized to the virtual controller by selecting Sync to VC. 

Notice that a RAPID procedure must follow the basic structure of a path to be 
supported in ArcWeld . 
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My Stations
ArcWeld is installed with a set of pre-designed RobotStudio stations. These are 
taken from the Virtual FlexArc library and they are exact replicas of ABB's FlexArc 
stations sold on the US market. These stations can be used for off-line 
programming or for training and demo purposes. The stations can easily be 
loaded via the ArcWeld loader interface: 
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In each station you will find that the robot has a mounted welding torch (Binzel 
Robo 455 w/ 22.5 degree neck) and defined TCP (tooldata = tWeldGun). We 
have also included a simple demo part and fixture with a defined workobject 
(wobjdata = obSTN_1). Models of BullsEye, torch service center (TC-97) and a 
Miller wire feeder are also included: 



88

Each station has its unique virtual controller, which come pre-installed with a 
number of useful software options: 

Simulated Welder 
Calibration instructions 
BullsEye 
Error Handler 
Seam Displacement 
Weld Parameter Limitation 
SmarTac 
TorchClean (TC-97) 

These options are included in the external option disk US-FLEXARC-X.XX, which 
is installed in the MediaPool. The user have to use the included instruction-set 
ArcEscX to get access to the options listed above. Use the Process Template 
ArcEsc.xml when programming in ArcWeld. Some features in ArcWeld will only be 
enabled when used with this instruction-set, such as: 

Save Project 
Block Process 

Adding New Stations to My Stations
The stations listed in My Stations View are installed in the directory C:Data/ 
RS_MyStations / 
You will find a text file called MyStationsList.txt, which describes the content of My 
Stations View.  
Each Station has its own directory and sub-directories. You can add your own 
stations to this by following this example: 

Add these directories and files to the directory C:Data/RS_MyStations/ 
MyStation/ 
MyStation/Stations/MyStation.stn 
MyStation/Stations/MyIcon.bmp 
MyStation/SystemPool/MyController 

Add these lines to the file C:Data/ RS_MyStations /MyStationsList.txt 
RsCaption:=My Station  
RsStationFile:=MyStation\Stations\MyStation.stn  
RsStationIcon:=MyStation\Stations\MyStation.bmp 
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Pre-installed Stations
Model:FlexArc_250B  
Station File:FlexArc_250B\Stations\FlexArc_250B.stn  
Icon File:FlexArc_250B\Stations\250B.bmp 

Model: FlexArc_250K_d1000
Station File: 
FlexArc_250K_d1000_l2500\Stations\FlexArc_250K_d1000_l2500_IRB1400.stn  
Icon File: FlexArc_250K_d1000_l2500\Stations\250K.bmp 

Model: FlexArc_250K_d1200
Station File: 
FlexArc_250K_d1200_l2500\Stations\Flexarc_K250_d1200_l2500_IRB2400L.stn  
Icon File: FlexArc_250K_d1200_l2500\Stations\250K 2400L.bmp 

Model: FlexArc_250R  
Station File: FlexArc_250R\Stations\FlexArc_250R_IRB1400.stn  
Icon File: FlexArc_250R\Stations\250R.bmp 

Model: FlexArc_500C  
Station File: FlexArc_500C\Stations\FlexArc_500C_IRB1400.stn  
Icon File: FlexArc_500C\Stations\500C.bmp 

Model: FlexArc_Compact  
Station File: FlexArc_Compact\Stations\Compact.stn  
Icon File: FlexArc_Compact\Stations\Compact.bmp 

Model: FlexArc_Compact_M  
Station File: FlexArc_Compact_M\Stations\Compact_M.stn  
Icon File: FlexArc_Compact_M\Stations\CompactM.bmp 

Model: FlexArc_U2  
Station File: FlexArc_U2\Stations\Flexarc_U2_1400.stn  
Icon File: FlexArc_U2\Stations\U2.bmp 

Notice that you can always open these stations the traditional way via the File 
menu in RobotStudio. 
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Help
The Help for ArcWeld is meant to provide quick, easily accessible information. 
The table of contents include five sections;  

Installation 
Introduction to RobotStudio 
Introduction to ArcWeld 
Working with ArcWeld 

There is an index that lists all topics and keywords of the documentation, and 
there is a search section where you can look for information on a certain topic. 

What is Online Help?
The term "Help" refers to the complete electronic documentation set provided 
along with the application. Help is sometimes called "online Help," but in this 
context, "online" simply means that the Help is delivered in an electronic format (it 
does not mean that the Help necessarily comes from the Internet). It provides 
support to users who might otherwise have to call for technical support. The best 
way to get assistance while you work is to use this help documentation. Use the 
help documentation online or the printed User's Guide. 
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Working with ArcWeld 
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Getting Started
1. Start RobotStudio with an empty station. 

2. Push the ArcWeld tab to view the ArcWeld loader. Notice that you can launch 
the ArcWeld Help and learn About ArcWeld. 

3. Before you can load the ArcWeld PowerPac, you have to open a station and 
make sure the Virtual Controller is started. Use the MyStations View to open one 
of the pre-installed FlexArc stations. These stations all include demo parts, 
welding torches and pre-configured virtual controllers.  
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4. Once a station is open the ArcWeld PowerPac View is opened and you can 
now start the virtual controller. 
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5. The ArcWeld icon is visible when the virtual controller has started. You can also 
choose to shut down the virtual controller.  

6. Load ArcWeld!
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Arc Weld User Interface
The ArcWeld user interface is designed to guide you step-by-step through the 
process of creating an arc-welding program. The user interface will change views 
dynamically depending on what the current task is. The three main views are 
Modules View, Create View and Edit View. 
From the Modules View you also have access to the three template views; 
Process Template View, Weld Template View and Search Template View.  

To resize the ArcWeld window, use the arrow keys  at the top of the 
application. Push the   button to launch the online help, and close the 
application by pushing the  button in the upper right corner. 
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Each view in ArcWeld is using design elements such as; browser, toolbars and 
frames. 

Browser: The browser provide an overview of the program modules, weld 
sequences and paths in the active station. 

Toolbars: The ArcWeld application views have dynamic structures controlled by 
toolbars. Push a button on a toolbar and notice how the view changes 
appearance. Different frames will be visible depending on which function you 
select. The main toolbars are; Modules Toolbar, Create Toolbar and Edit Toolbar. 

Frames: Each function is using a combination of frames. A frame is dynamic and 
adapts its contents to the selected function. For instance, the Info Selected Item 
frame will list different information depending on which item is selected in the 
browser. Some frames can be expanded with an arrow button. Push this button to 
display more functions. The frame can be collapsed by pushing the same button 
again. 
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Modules View 
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Modules View

The Modules View is the starting point when working with ArcWeld, and it 
provides an overview of the program modules in the active station. The Browser 
displays all program modules, weld sequences and paths in a tree structure. 
Information on a specific item is displayed in the Info Selected Item fields. To add 
and remove items in the browser, you can select functions from the Modules 
Toolbar or from the Context Menu. 

A typical work session in ArcWeld starts with creating a new Program Module in 
the Browser. You can then insert weld sequences and weld paths in the tree 
structure. Right-click on a path and select Create Targets from the context menu 
to start the programming. This will take you to the Create View where welds, air 
moves and search moves can be created. Once the targets are created you can 
switch to the Edit View. This is where you make modifications and test the path 
before returning to the Modules View. You can then execute a weld sequence or 
a path from the Modules Toolbar, as well as synchronizing the data to the virtual 
controller.  
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From the Modules View you also have access to the three template views; 
Process Template View, Weld Template View and Search Template View. 
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Browser

The Browser displays all program modules, weld sequences and paths in the 
active station. Select a node in the browser and various information about the 
selected item will be displayed in the Info Selected Item fields. You can add and 
delete nodes in the browser by using the Modules Toolbar. You can also control 
the browser by using the Context Menu. The status of an item is displayed with 
different colors of the node icon. You can read more about node status in the 
concepts section. 
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Info Selected Item

Information will be displayed in the Info Selected Item fields, when selecting a 
node in the Browser. The different information fields are: 

Type: The type of the selected item 

Name: The name of the selected item 

Status: The status of the selected item. The status is also indicated by the colors 
of the icon in front of each item in the Browser. 

Path Info: This frame is only visible when the check-box is checked. 

Info: Descriptive information about the path, such as information about the 
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weld size, purpose, quality (e.g. "Fillet weld, joining base plate and bracket, 
low stress restrictions"). This text will show up as a TPWrite instruction in the 
RAPID code. 

Push the arrow button to expand the frame for more information. 

Used Tool: Tooldata used when creating the path. 

Used WObj: Work object used when creating the path. 

Mech Unit: Mechanical unit activated when programming coordinated 
motion. 

Path Status: Status and total number of targets in the path. 

Path Visibility/Color: This frame controls the visibility and color of the selected 
path.

Not Visible: Hides all targets and the path 

Path Only: Hides all targets. Shows the path. 

All Targets: Shows all targets. Hides the path. 

First/Last: Shows only the first and the last target in the selected path. 

Process Points: Shows only the targets in the welds in the selected path. 

Path Color: This frame controls the color of the selected path.  

Path: Push this button to open the color palette. Set a new color for the 
selected path 

Process: Sets a different color on the path between the process targets in 
the path. 
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Modules Toolbar

The browser toolbar provides the following functionality; 

Insert
Inserts a new node in the browser's tree structure.  

Copy
Makes a copy of the selected path and puts it in a buffer.  

Paste
Pastes the copied path from the buffer into the selected weld sequence. 

Save Project
Saves program modules included in project. Only available when used with US-
FLEXARC-X.XX media. 

Delete
Deletes the selected item. 

Refresh
Updates the browser. 

Execute
Executes the selected item. Notice that the item is executed without being 
synchronized with the Virtual Controller. 

Stop
Stops execution. Notice that this function is only available when ArcWeld 
Powerpac I/O is loaded into the VC. 

Sync
Synchronizes the item to the Virtual Controller. 

Move to Start
Moves the robot to the defined Start Position. 
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Collision Sets
Activates or deactivates collision sets. Must be active when running path planner. 

Block Process
By blocking the process the system uses programmed speed instead of process 
speed when executing a path. Only available when used with instruction-set 
ArcEscX (included in media US-FLEXARC-X.XX). 

Set View Center to TCP
Sets view center to XYZ of active TCP. 
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Context Menu
Open the context menu by right-clicking on a node in the browser. Notice that the 
menu is context sensitive and will contain different functions depending on which 
node is selected. 

Create Targets
The application changes view from Modules View to Create View. 

Edit
The application changes view from Modules View to Edit View. 

Insert
Inserts a new path node in the browser's tree structure 

Execute
Executes the selected path or weld sequence. Notice that the path/weld 
sequence is executed without being synchronized with the Virtual Controller. 

Sync
Synchronizes the selected item and its sub-components to the Virtual Controller. 

Copy
Makes a copy of the selected path. 

Delete
Deletes the selected path and its targets. If a weld sequence is selected the 
included paths have to be deleted individually before the weld sequence can be 
deleted. All weld sequences in a module have to be deleted before a module can 
be deleted. 

Insert Module
Inserts a new module node in the browser's tree structure 

Insert Weld Sequence
Inserts a new weld sequence node in the browser's tree structure 

Insert Path
Inserts a new path node in the browser's tree structure 
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Set Invisible
Hides the selected item 

Set Visible
Shows the selected item 

Set all Paths Invisible
Hides all paths in the station 

Set all Paths Visible
Shows all paths in the station 

Set as Start Pos
Defines the current robot position as Start Position  

Go to Start Pos
Moves the robot to the defined Start Position. 

Show RAPID
Opens separate viewer for the RAPID code. 
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Create View 
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Create View

The Create View provides an overview of the loaded path and lists all targets in 
the Target List. Information on the loaded path is displayed in the Path Settings 
fields. The create view also include the Create Toolbar. 

You can switch to the Edit View by pushing the Edit button or return to the 
Modules View by pushing the Modules button. 
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Path Settings

Active settings will be displayed in the Info Loaded Path fields, when creating a 
new path. The different fields are: 

Name: The name of the path 

Info: Descriptive information about the path. This could be information about the 
weld size, purpose, quality (e.g. "Fillet weld, joining base plate and bracket, low 
stress restrictions"). This is optional information for the user and the field can be 
left blank. 

Tool: Active Tool used when creating the path. Note that this setting can only be 
changed before a weld is added to the new path. You can also choose in which 
module the data will be written to when synchronizing the path to the virtual 
controller. The drop-down menu lists all available modules in the Virtual 
Controller. After a weld is added the settings will be grayed out for read-only 
purpose.

Work Object: Active Work Object used when creating the path. Note that this 
setting can only be changed before a weld is added to the new path. You can also 
choose in which module the data will be written to when synchronizing the path to 
the virtual controller. The drop-down menu lists all available modules in the Virtual 
Controller. After a weld is added the settings will be grayed out for read-only 
purpose.

Mech Unit: Defines which mechanical unit to be activated when creating targets. 
Once a mechanical unit is selected for a path it can not be changed. 
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Target List

The target list displays all targets in the loaded path. Select a target by clicking in 
the list, and notice that the line is highlighted in dark blue. Step up and down in 
the target list by using the scroll buttons to the right. You can also select several 
targets by using the multi-selection buttons; 

Target: Selects only one target 
Sel: Selects a sequence of targets in the weld (classification type 
ProcStart, ProcVia and ProcEnd). 
Weld: Selects all targets in the weld (classification type ProcStart, ProcVia 
and ProcEnd). 
Path: Selects all targets in the path 

All targets in the target list have attributes. Use the scroll-bar at the bottom of the 
target list to view all target attributes. Each target in the target list has the 
following attributes;  

Index - sequence number in the list 
Status - shows different colors depending on current Target Status 
Type - shows different RAPID instructions depending on current Target 
Classification 
Motion - shows different Motion Type depending on current Target 
Classification 
Target Name - name of target in RobotStudio and robtarget name in 
RAPID.
Process/Template - (see Process/Template below) 
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Optional Attr - (see Optional Attributes below) 
Seam Name - (see Seam Name below) 
Escape Path - (see Escape Path below) 

Process/Template
Non-process targets (air, approach, depart) are indicated with the word Move, 
which means that the RAPID instruction MoveJ/MoveL will be used. Process 
targets have process template as attribute (in this case the "Default data set" 
process template). Notice that a process template will apply to all targets in a 
weld, and you only have to change the attribute of the first target. Search targets 
are indicated with the word Search_1D, which means that the RAPID instruction 
Search_1D will be used.  

Optional Attributes 
Approach/Depart targets have an optional attribute that controls the distance to 
ProcStart/ProcEnd. Search targets have an attribute that controls the search 
distance. You can select and change these attributes in the drop-down menus. 
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Seam Name
Name of weld in RobotStudio and optional argument in the ArcL/ArcC instruction. 
For search moves the name is an optional argument in the Search_1D instruction.  

Escape Path
Name of escape path used for moving from path to home position. Only available 
when used with instruction-set ArcEscX (included in media US-FLEXARC-X.XX).  
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Create Toolbar

Select a function by pushing a button on the Create Toolbar. The contents of the 
Create View will change dynamically depending on selected function. The 
function will remain active until the button is pushed again. 

The Create Toolbar provides the following functionality;  Add Weld, Insert Linear 
Process Point, Insert Circular Process Point, Add Air Move and Insert Search 
Move. 

You can copy and paste targets by using the Copy and Paste buttons. Notice that 
you can only copy an entire weld or individual air targets. These selections are 
controlled with the multi-selection buttons in the Target List. Select where to insert 
the copied targets in the target list before pushing the Paste button. 

The create toolbar also includes the buttons Path Planner and Set View Center to 
Target. 
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Add Weld
Push the Add Weld button to add a weld to the loaded path. This function is 
enabled only if the path is empty or if the selected target in the target list is of 
classification type Process End, Depart Move or Air Move. 

Five new frames will appear when pushing the Add Weld button and the target list 
will disappear. The new frames are used to set parameters before generating the 
weld. The five frames are; Path Settings, Selected Positions, Process Template, 
Weld Template, and Robot Configuration. 

Example:
The default weld template "Linear two point" is selected, which makes the 
Selected Positions field list three items; Start Point, End Point and Base Plate 
Face. The first line is automatically highlighted and the application expects the 
user to click in the graphics window. Click on the part where you want the weld to 
start. Use the Selection Levels and the Snap Modes toolbars in RobotStudio to 
make the cursor snap to the corner. The XYZ coordinates of the picked position 
will be entered in the Start Point fields. Notice that a spherical yellow marker will 
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indicate the picked position in the graphics window. 

Then the End Point line is highlighted. Click on the part where you want the weld 
to end. The XYZ coordinates of the picked position will be entered in the End 
Point fields. Notice that a spherical red marker will indicate the picked position in 
the graphics window. 

Finally the Base Plate Face line is highlighted. Pick the base plate face to set the 
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z-orientation of the reference coordinate system. The XYZ coordinates of the 
picked position will be entered in the Base Plate Face fields. The z-orientation will 
be indicated by a cylindric blue marker in the graphics window. 

Push the Apply button to generate the weld. Four targets will be created; 
Approach, Process Start, Process End and Depart. Each target is represented by 
a small coordinate system in the graphics window, they will also be added to the 
Target List. 
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Selected Positions

The Selected Positions frame may look different depending on which weld 
template is selected in the Weld Template frame, or which function in the Create 
Toolbar is active. 

When a line in the Selected Positions frame is highlighted, the application expects 
the user to click in the graphics window. The XYZ coordinates of the picked 
position will be entered in the highlighted field. 

When all fields contain XYZ coordinates the Apply button will be enabled. Push 
the Apply button to execute the current function. 
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Process Template

The process template is a collection of process parameters and instruction 
settings. The selected process template will be used to set process parameters 
on a weld, when the Add Weld function is executed. 

The first section holds a drop-down menu, where a predefined process template 
can be selected. In the picture above, the "Default data set" is selected. You can 
create new templates from the Process Template View. 

The second section is optional, and will only be used if the Optional Attributes 
check-box is checked. The seam name is an optional argument in the ArcL/ArcC 
instruction.  

The third section holds a data field for entering a text description. This information 
is not transferred to the RAPID code. 

The fourth section holds optional text fields for entering additional information to 
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the weld. This information is not transferred to the RAPID code. 

The fifth section holds parameters for process data (seamdata, welddata, 
weavedata and trackdata), which is loaded from the virtual controller when the 
ArcWeld application is started. The selected parameters will be set for all process 
targets in the weld when the weld is created. It is possible to change the values 
on individual parameters at any time. 

The sixth section holds settings for RAPID instructions. Instruction parameters 
(motion type, speed and zone) will be set for all targets in the weld when the weld 
is created. Different parameters will be set on targets depending on target 
classification. It is possible to change the values on individual parameters at any 
time.
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Weld Template

The weld template is a collection of weld parameters. A number of predefined 
weld templates can be selected from the drop-down menu. The selected weld 
template will be used to set weld parameters on a weld, when the Add Weld 
function is executed. 

Example:
In the picture above, the "Linear two point" weld template is selected. This 
particular template will generate a start and an end target. Torch Angles (Work 
Angle, Push/Drag and Spin) are set for the individual targets. It is possible to 
change the values on individual parameters at any time. "Auto" means that the 
spin angle will be automatically set, so that the x-axis of the TCP points towards 
the base of the robot. 

If the "Add Approach Move" check-box is checked, a target will be created 50 mm 
away from the start target, along the start targets z-axis. The distance can be set 
to a different value. The approach target will get the same torch angles as the 
start target. 

If the "Add Depart Move" check-box is checked, a target will be created 50 mm 
away from the end target, along the end targets z-axis. The distance can be set to 
a different value. The depart target will get the same torch angles as the end 
target.

As a result, four targets will be generated. 
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Insert Linear Process Point
Push the Insert Linear Process Point button to add a linear process segment to 
the loaded path. This function is enabled only if the selected target in the target 
list is a process point (see Target Classification). 

Four new frames will appear when pushing the Insert Linear Process Point button 
and the target list will disappear. The new frames are used to set parameters 
before generating the process point. The four frames are; Path Settings, Selected 
Positions, Orientation for New Targets and Robot Configuration. 

Two points are needed when creating a linear segment. The selected target in the 
Target List will automatically be used as the start point, and its XYZ-coordinates 
will be displayed in the Last Target field. Pick the end point in the graphics 
window, and then pick the Base Plate Face to set the UCS orientation. Finally, 
push Apply to complete the linear segment. 

The torch angles from the start point are automatically displayed in the Orientation 
for New Targets frame. These torch angles will be used also for the end point 
target. It is possible to change angle values before creating the linear segment. 
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Insert Circular Process Point
Push the Insert Circular Process Point button to add a circular process segment 
to the loaded path. This function is enabled only if the selected target in the target 
list is a process point (see Target Classification). 

Four new frames will appear when pushing the Insert Linear Process Point button 
and the target list will disappear. The new frames are used to set parameters 
before generating the process point. The four frames are; Path Settings, Selected 
Positions, Orientation for New target and Robot Configuration. 

Two points are needed when creating a circle segment. The selected target in the 
Target List will automatically be used as the start point, and its XYZ-coordinates 
will be displayed in the Last Target field. Pick the circle point and the end point in 
the graphics window. Finally, push Apply to complete the circle segment. 

The torch angles from the start point are automatically displayed in the Orientation 
for New Targets frame. These torch angles will be used also for the other targets 
in the circle segment. It is possible to change angle values before creating the 
circle segment. 
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Add Air Move
Push the Add Air Move button to add an air target to the loaded path. This 
function is enabled only if the selected target in the target list is a non-process 
point (see Target Classification). 

Four new frames will appear when pushing the Add Air Move button and the 
target list will disappear. The new frames are used to set parameters before 
generating the air move. The four frames are; Path Settings, Selected Positions, 
Instruction Arguments and  New Target. 

The Air Point is used to set the position of the air target. Click in the graphics 
window, or type XYZ-coordinates in the Air Point field, or push the On Tool button. 
The On Tool button automatically gets the XYZ-coordinates from the active TCP.  

The instruction arguments from the previous target are displayed in the Instruction 
Arguments frame. These arguments will be used also for the air move target. It is 
possible to change instruction arguments before creating the air move target. 

You can select if the new target should be inserted before or after the target you 
selected in the target list. The new target will appear in the target list and will be 
classified as air target.
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Insert Search Move
Push the Insert Search Move button to add a search sequence to the loaded 
path. This function is enabled only if the selected target in the target list is a non-
process point (see Target Classification). 

Two new frames will appear when pushing the Insert Search Move button. The 
new frames are used to set parameters before generating the search sequence. 
The two frames are; Selected Positions and Search Template. 

When a line in the Selected Positions frame is highlighted, the application expects 
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the user to click in the graphics window. The XYZ coordinates of the picked 
position will be entered in the highlighted field. The following two positions are 
needed to create a search move: 

Search Point: The position on the surface where the torch/wire will touch. 

Tool Z Dir: Click on the surface to set the tool orientation in relation to the search 
point. The wire (z-direction of TCP) will point towards this position. 

When all fields contain XYZ coordinates the Apply button will be enabled. When 
you push the Apply button a search move will be created based on the currently 
selected Search Template. Tool orientation will automatically be calculated based 
on the search template settings and the search tool geometry.  
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Search Template
Before you can create a search move you have to select search parameters in the 
Search Template frame. The search template view allows you to create different 
instances of these templates. ArcWeld will create two robtargets in the search 
move, and when the targets are synchronized to the virtual controller a 
Search_1D instruction will be generated. 

Search_1D is a RAPID instruction used for tactile searching of a feature with 
SmarTac (read more in the SmarTac User's Guide). The search path is described 
by two required robtargets. The search result is stored as pose data in the 
required argument ‘Result’. 

Example - Instruction: 
Search_1D peResult,p1,p2,v200,tWeldGun;

When executed, the robot makes an ‘L’ move to the start point, p1. 
The SmarTac board is activated and motion starts towards the search 
point, p2. The robot moves on a linear path from p1 through p2. The 
robot will continue past the search point for a total distance described 
by twice the distance between start point and search point. When 
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contact is made with the part feature, the difference between the 
contact location and p2 is stored in peResult. This program 
displacement can later be used to shift programmed points using the 
RAPID instruction PDispSet.

Example - Single dimension search in any direction:
MoveJ *, vmax,fine, tWeldGun;
Search_1D peResult,p1,p2,v200,tWeldGun;
PDispSet peResult;
ArcL\On,*,vmax,sm1,wd1,wv1,z1,tWeldGun;
ArcL\Off,*, vmax,sm1,wd1,wv1,z1,tWeldGun;
MoveJ *, vmax,z10, tWeldGun;
ArcL\On,*,vmax,sm1,wd1,wv1,z1,tWeldGun;
ArcL\Off,*, vmax,sm1,wd1,wv1,z1,tWeldGun;
PDispOff;

Each template has a number of different parameters to support the Search_1D 
instruction. These are the search parameters; 

Search Name: If selected, the search will be assigned with this identifying name. 
The name will accompany any error messages that are written to the User Error 
Log.

Add PDispOff Before: Adds the PDispOff RAPID instruction before the search 
instruction. 

Add PDispSet After: Adds the PDispSet RAPID instruction after the search 
instruction. 

Insert Before/After: Inserts the search move before/after the selected target in 
the target list. 

Template Type: In this version of ArcWeld there is two different type of 
templates; One Dimension Gas-Cup Search and One Dimension Wire Search.

Search Inst: In this version of ArcWeld only one type of RAPID search instruction 
is supported; Search_1D. 

Search Type: Defines if the gas-cup or the wire is used for touch sensing. 



128

Gas-Cup Touch            Wire Touch

To Speed: The speed data used when moving to the StartPoint. The velocity of 
the search motion is unaffected. 

Search Dist: The distance (mm) between the Start Point and the Search Point of 
the search move, perpendicular to the surface. 

Spin Angle: Spin angle around z-axis of TCP (see also Torch Angles). "Auto" 
means that the spin angle will be automatically set, so that the x-axis of the TCP 
points towards the base of the robot. 

Clear Dist (A): The perpendicular distance (mm) from the surface that the 
wire/gas-cup clears. 

Result: The displacement frame that will be updated (pose data). 

PrePDisp: If selected, the search will be conducted with this displacement frame 
active, effectively adding the two displacement frames. This may or may not be 
the same as the pose data selected for Result. 
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Search Tool Geometry
ArcWeld needs to know the gas cup diameter and the wire stick out, to be able to 
calculate torch angles based on the search parameters. Use the measurement 
tools in RobotStudio to measure these dimensions, and insert the numbers in the 
Search Template. If the torch in RobotStudio does not match the real torch 
exactly, you can take measurements from the real torch instead. Notice that you 
can create and delete instances of tool geometry in the Search Template View. 

Gas Cup Diameter (X): The diameter (mm) of the gas cup at the tip of the weld 
torch.

Wire Stick Out (Y): The stick out distance (mm) of the wire. 
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Edit View 
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Edit View 
The Edit View provides an overview of the loaded path in the Target List. Detailed 
information on selected targets is displayed in six different frames. The six frames 
are; View Settings, Path Settings, Target Position, Target Orientation, Robot 
Configuration and External Axes Values. The edit view also include the Edit 
Toolbar. 

You can switch to the Create View by pushing the Create button or return to the 
Modules View by pushing the Modules button. 
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View Settings

View At Target
It is possible to choose between three different settings to highlight a selected 
target in the graphics window. When selecting a target in the Target List one of 
the three following settings will help you find the selected target; 

Indicator: The tool indicator resembles the shape of a weld torch. It gives you a 
chance to view the torch angles with out having to use the robot or the active tool 
center point (TCP). 

Active Tool: Automatically puts the weld torch with its active TCP at the selected 
target without using the robot. It gives you a chance to view torch angles, and 
clearance between the torch and the part.  
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Auto Jump To: Automatically jumps the robot with active TCP to the selected 
target. It gives you a chance to view torch angles, clearance between the torch 
and the part, and detect possible collisions with the robot. 

Indicator Size
It is possible to change the size of the tool indicator. You can choose between 
large, medium and small. 



134

Large Indicator

Medium Indicator
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Small Indicator
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Target Position

The Target Position frame contains information about a targets position, 
represented in XYZ coordinates (mm). The coordinates can be in reference to; 
RCS, oframe (WorkObject), World or UCS. 

You can change coordinates by entering numbers from your keyboard, or by 
clicking in the graphics window, or by using the arrow keys. One click on an arrow 
key changes the value with 100 mm, or if the Fine check-box is checked it 
changes the value with 1 mm. 

The ModPos button will be enabled if an air target is selected in the Target List. 
The selected target will move to the current position of the TCP when pushing the 
ModPos button. 

You can choose to work in absolute or relative coordinates. Relative means that 
you can offset a target relative to itself. 
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Target Orientation

The Target Orientation frame contains information about a targets orientation, 
represented in angle values (degrees). The angles can be in reference to; RCS, 
oframe (WorkObject), World or UCS. 

If RCS is selected as reference, the orientation is represented in Torch Angles. 
Any other selection will represent the orientation in Euler angles (see RobotStudio 
Help). 

You can change angle values by entering numbers from your keyboard, or by 
using the slide bars, or by using the arrow keys. One click on an arrow key 
changes the value with 5 degrees, or if the Fine check-box is checked it changes 
the value with 1 degree. 

You can choose to work in absolute or relative angles. Relative means that you 
can rotate a target relative to itself.  

A number of special functions are available in the drop-down menu: 

Copy Spin from Selected: Orients all selected targets x axis the same as x axis 
of selected target (z axis is fixed) 

Spin tool X towards picked position: Spins the tool so that the X-axis of TCP 
points towards a position picked in the graphics window. 

Spin tool X towards robot base: Spins the tool so that the X-axis of TCP points 
towards the base of the robot. 

Align RCS Z Axis to surface: Realigns the reference coordinate system (RCS) 
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so that the Z-axis is perpendicular to a surface selected in the graphics window. 

Spin RCS X towards picked position: Spins the RCS around the z axis so the x 
axis points towards picked position. 
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Robot Configuration

The robot configuration control is used to select robot configuration for individual 
targets. Settings will be used to select robot configuration. The control includes six 
settings;

Defined: Is automatically checked when a robot configuration is selected and the 
robot has successfully moved to the target.  

Information Field: Shows the selected configuration values e.g. [0,-1,0,0]. It will 
also display one of the following colors; 

White: Configuration unknown.
Green: Configuration calculated and tested by moving the robot to the 
target. 
Yellow: Configuration calculated, but not tested.
Red: Configuration not found.

Wrist Center: This control is used to specify if the robot wrist is in front or behind 
of the robot. 

Axis 4: This control is used to specify if axis 4 is going to be turned positive or 
negative. If the selection 0 is used, the configuration of axis 4 will be controlled by 
axis 5. 

Axis 5: This control is used to specify if axis 5 is going to be turned positive or 
negative. If the selection 0 is used, the configuration of axis 5 will be controlled by 
axis 4. 

Axis 6: This control is used to specify if axis 6 is going to be turned positive or 
negative. If the selection 0 is used, the configuration of axis 6 will be controlled by 
axes 4 or 5. 
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External Axes Values

The External Axes Values frame contains information about a targets external 
axes values, represented in degrees. It shows external axes values for up to six 
logical axes. If a logical axis is deactivated its external axis value will be 
represented with the symbol ***. 

You can change external axis values by entering numbers from your keyboard, or 
by using the slide bars. One click on the slide bars arrow keys changes the value 
with 1 degree. If the Fine check-box is checked the slide bar range is +/- 360 
degrees. If the Fine check-box is unchecked the slide bar range is +/- maximum 
joint limits.

The Path Pitch gauge displays the angle (degrees) of the weld in relation to a 
horizontal plane. The indicator line will tell you if you are welding uphill, flat or 
downhill. 

The Path Roll gauge displays the angle (degrees) of the torch in relation to a 
vertical plane. 

External axes values for a target can either be changed relative to the current 
position of the external axes, or with absolute angle values. The drop-down menu 
at the bottom of the External Axes Values frame provides special functions: 

Interpolate External Axes: Interpolates external axis values over a sequence of 
targets. 
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Edit Toolbar

Select a function by pushing a button on the Edit Toolbar. The contents of the Edit 
View will change dynamically depending on selected function. The functionality 
will remain active until the button is pushed again. 

The Edit Toolbar provides the following functionality; Define UCS, Edit Target 
Names, Mirror Selected Targets, Reverse Selected Targets, Scale Selected 
Targets, Delete Selected Target, Jump To Target, Move To Target, Reverse To 
Target,  Execute Loaded path, Stop Execution and Set View Center to Target. 
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Define UCS
This function will help you redefine the position of the UCS. Only the Selected 
Positions frame will appear when pushing the Define UCS button. 

To define the UCS follow these steps: 
1. Push the Define UCS button on the Edit Toolbar.  
2. Pick the Origin of the UCS in the graphics window. 
3. Pick a point on the x-axis of the UCS in the graphics window. 
4. Pick a point on the xy-plane of the UCS in the graphics window. 
5. Push apply to make the change. 
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Edit Target Names
This function will help you rename all targets in the loaded path.  

When the targets are created they will be given default names (Target1, Target2, 
Target3 etc). By using the Edit Names function you will be able to rename the 
targets with a new common prefix. The targets will get an extension with the index 
number. 

In the picture above we have used the prefix "pMyPath_". After pushing the apply 
button, the targets in the path got the names pMyPath_1, pMyPath_2, pMyPath_3 
and pMyPath_4. 
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Mirror Selected Targets
This function is enabled only if a range of targets is selected. Following 
parameters have to be set before mirroring the targets; Mirror Coordinate System 
and Mirror Plane. 

It is possible to displace targets in relation to different mirror references. You can 
choose to mirror in reference to oframe (Work Object), World or UCS. Once you 
have selected mirror coordinate system you have to select the mirror plane within 
that coordinate system. You can choose to mirror in reference to XZ-plane, YZ-
plane or XY-plane. Then push Apply to displace the selected targets. 
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Reverse Selected Targets
This function is enabled only if a weld or a complete path is selected. It will 
reverse the order of the selected targets. Notice that torch angles will be 
recalculated so that push/drag angles will remain consistent.  

To reverse the order of the targets in the path, follow these steps: 
1. In the Target List, select the targets you want to delete. 
2. In the Edit Toolbar, click the Reverse Selected Targets button. 
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Scale Selected Targets
This function is enabled only if a range of targets is selected. Following 
parameters have to be set before mirroring the selected targets; Reference 
Coordinate System and Scale Factors. 

It is possible to scale targets in relation to a reference coordinate system. You can 
choose to scale in reference to oframe (Work Object), World or UCS. Once you 
have selected reference coordinate system you have to select the scale factors 
within that coordinate system. You can choose to scale in reference to the X, Y 
and Z axis individually. Then push Apply to displace the selected targets. 
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Delete Selected Target
This function is enabled only if a single target is selected. It will delete the target 
and then update target classification within the path.  

To delete a target, follow these steps: 
1. In the Target List, select the target you want to delete. 
2. In the Edit Toolbar, click the Delete Selected Target button. 
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Jump To Target
This function will help you determine if a target is within reach of the robot, and is 
enabled when a single target is selected.  

To make the robot jump to a target, follow these steps: 
1. To be able to jump the robot to a target, the Virtual Controller must be running 
and any used external axis have to be connected. 
2. In the Target List, select the target you want the robot to jump to. 
3. In the Edit Toolbar, click Jump To Target. The robot will jump to the chosen 
target. No motion planning will take place; it is only a mathematical calculation to 
check that the robot can reach the target. 

A successful execution of this command will turn the status field in the target list 
yellow, which means that the target is reachable but execution has not yet been 
verified by the robots motion planner. A non-successful execution of this 
command will turn the status field in the target list red, which means that the 
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target is out of the robots reach. Use the following controls in the Edit View to tune 
the target until it is reachable; Target Position, Target Orientation, External Axes 
Values.
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Move To Target
This function will help you determine if the robot can move to a target from the 
previous target in the target list. You can also select a range of targets and move 
the robot in sequential order down the target list.  

To make the robot move to a target, follow these steps: 
1. To be able to move the robot to a target, the Virtual Controller must be running 
and any used external axis have to be connected. 
2. In the Target List, select the target(s) you want the robot to move to. 
3. In the Edit Toolbar, click Move To Target. The robot will move to the chosen 
target(s) using the motion properties defined in the target(s). 

A successful execution of this command will turn the status field in the target list 
green, which means that the target is reachable and execution has been verified 
by the robots motion planner. A non-successful execution of this command will 
turn the status field in the target list red, which means that the target is out of the 
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robots reach. Use the following controls in the Edit View to tune the target until it 
is reachable; Target Position, Target Orientation, External Axes Values. 

Notice that the virtual controller is not using process parameters when executing 
this command. To execute with process parameters run the Execute Loaded Path 
command
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Reverse To Target
This function will help you determine if the robot can move to a target from the 
subsequent target in the target list. You can also select a range of targets and 
move the robot in reverse order up the target list. 

To make the robot reverse to a target, follow these steps: 
1. To be able to reverse the robot to a target, the Virtual Controller must be 
running and any used external axis have to be connected. 
2. In the Target List, select the target(s) you want the robot to reverse to. 
3. In the Edit Toolbar, click Reverse To Target. The robot will reverse to the 
chosen target(s) using the motion properties defined in the target(s). 

A successful execution of this command will turn the status field in the target list 
green, which means that the target is reachable and execution has been verified 
by the robots motion planner. A non-successful execution of this command will 
turn the status field in the target list red, which means that the target is out of the 
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robots reach. Use the following controls in the Edit View to tune the target until it 
is reachable; Target Position, Target Orientation, External Axes Values. 

Notice that the virtual controller is not using process parameters when executing 
this command. To execute with process parameters run the Execute Loaded Path 
command
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Execute Loaded Path
This function will execute the loaded path from start to end. Notice that the virtual 
controller is using process parameters when executing this command, which will 
simulate the exact behaviour of the weld process. 

To execute the loaded path, follow these steps: 
1. To be able to move the robot to a target, the Virtual Controller must be running. 
2. In the Edit Toolbar, click Execute Loaded Path. The robot will move along the 
path using the motion a and process parameters defined in the targets. 
3. To stop the robot push the Stop button. 
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Stop Execution
This function enables you to stop execution of a path. Notice that this function is 
only available when ArcWeld Powerpac I/O is loaded into the VC. 
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Set View Center to Target
This function sets the view center automatically to XYZ the selected target in the 
target list. 
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Template Views 
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Process Template View
The process template view is helping you create new instances of process 
templates.  

The toolbar provide four functions: 

Open: Opens a process template from file (.xml). 

Save: Saves selected process template to file (.xml). 

Copy: Makes a copy of the selected process template. 

Delete: Deletes the selected process template. 
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You are able to rename the template, after entering your comments and changing 
settings in the template. Checking the "Locked" check-box prevents users from 
over-writing your settings when the template is used in the AddWeld view. To 
learn how to create and save templates follow these procedures. 

1. Push the Copy button. A copy of the currently selected process template is 
created, and is named "Default data set_Copy". 

2. Rename the process template to "My Process Template", and change settings 
according to the picture below: 

3. Save the template to a file by pushing the Save button. The system suggest the 
file name "My Process Template.xml". Browse to a directory and save it to your 
hard drive. 
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4. Delete your new template by pushing the Delete button, and then select 
"Default data set" from the drop-down menu. 

5. Load your new template back by pushing the Open button, and select the file 
"My Process Template.xml". The template is now loaded back in the system. 
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Weld Template View
The weld template view is helping you create new instances of weld templates.  

The toolbar provide five functions: 

New: Creates a new template from a default template.  

Open: Opens a weld template from file (.xml). 

Save: Saves selected weld template to file (.xml). 

Copy: Makes a copy of the selected weld template. 

Delete: Deletes the selected weld template. 

You are able to rename the template, after entering your comments and changing 
settings in the template. To learn how to create and save templates follow these 
procedures. 

1. Select the weld template "Linear two point" from the drop-down menu and push 
the Copy button. A copy of the currently selected process template is created, and 
is named "Linear two point_Copy". 

2. Rename the process template to "My Weld Template", and change settings 
according to the picture below: 
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3. Save the template to a file by pushing the Save button. The system suggest the 
file name "My Weld Template.xml". Browse to a directory and save it to your hard 
drive. 

4. Delete your new template by pushing the Delete button, and then select "Linear 
two point" from the drop-down menu. 

5. Load your new template back by pushing the Open button, and select the file 
"My Weld Template.xml". The template is now loaded back in the system. 
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Search Template View
The search template view is helping you create new instances of search 
templates. 

The toolbar provide five functions: 

New: Creates a new template from a default template. 

Open: Opens a weld template from file (.xml). 

Save: Saves selected weld template to file (.xml). 

Copy: Makes a copy of the selected search template. 

Delete: Deletes the selected search template. 
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You are able to rename the template, after changing settings in the template. To 
learn how to copy and delete templates follow these procedures. 

1. Select the search template "One Dimension Gas-Cup Search" from the drop-
down menu and push the Copy button. A copy of the currently selected process 
template is created, and is named "One Dimension Gas-Cup Search_Copy". 

2. Rename the process template to "My Search Template", and make some 
changes to the parameters. 

3. Save the template to a file by pushing the Save button. The system suggest the 
file name "My Search Template.xml". Browse to a directory and save it to your 
hard drive. 

4. Delete your new template by pushing the Delete button, and then select "One 
Dimension Gas-Cup Search" from the drop-down menu. 

5. Load your new template back by pushing the Open button, and select the file 
"My Search Template.xml". The template is now loaded back in the system. 
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